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What's On......General Meeting Wednesday 1 September 2010 at
Buderim
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 1 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Wednesday between 9.30 am and 12.00 noon,
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina

Notice about SCCC Monthly General Meetings
The SCCC Monthly Meetings alternate between the Caloundra and Buderim venues. In Caloundra the meeting is held on the
first Saturday of the month and in Buderim the meeting is held on the first Wednesday of the alternate month.

The next SCCC Monthly Meeting will be at Buderim on Wednesday 1 September 2010 at 11.00 am.
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From The Editor - Heather Atkinson
Bits'N'Bytes is produced monthly from February to
December each year.
Contributions for the newsletter are always welcome.
Please send copy for the next issue to reach the editor
as early as possible after the monthly meeting or by the
deadline: 24 September 2010.
Email: editor@sccc.org.au or Snail Mail: The Editor PO
Box 549, Mooloolaba, Qld 4557.
This magazine is created with OpenOffice and
produced in printed form and also electronically
in PDF format.
Copyright - material in this newsletter may be copied
in other publications provided that copyright rests with
the Sunshine Coast Computer Club Inc., This permission
is on condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter are
checked for content, no warranty can be given for any
loss resulting from the use of material in the newsletter.
Articles and advertisements are printed in good faith
and views and opinions are not necessarily those held
by the club.
SCCC Privacy Statement - In joining the Sunshine
Coast Computer Club please note that it is a club
operated by volunteer members and operating within
the community involving many activities relating to
meetings, instructional and social functions for
members and at times visitors.

This requires the keeping of a member data base and
the publication of the names of new members. The
Club guards the member data base as best as possible
and does not publish member's addresses nor
telephone numbers unless authorised.
At times photographs are taken at meetings and
functions and are sometimes published. Should you
have any problems relating to your personal privacy
which arises or is likely to arise, it is your duty and
responsibility to advise the Club secretary in writing of
the circumstances and requirements.
What's on Bulletin - What's On Bulletins are sent once
a week, generally on a Monday afternoon, to all members
who have provided the Club with their email address.
These bulletins give details of up-coming tutorials and
topics to be covered at the various meeting venues. You
will also find items of interest and club announcements in
these bulletins.
Membership Cards for Collection - Membership
cards for those members who joined or renewed
membership for the month ending 20 August 2010 are
available for collection at Caloundra and Buderim
meetings. Cards that have not been collected in the
previous twelve months are also available.
Note - Membership cards show the next renewal date
of membership.

AUSTRALIAN SENIORS COMPUTER COMPUTER CLUBS
ASSOCIATION (ASCCA) AUG 10 NEWSLETTER
The Sunshine Coast Computer Club Inc is a member of the
Australian Seniors Computer Clubs Association - ASCCA .
ASCCA issues a Monthly Newsletter
The Aug 10 Newsletter may be viewed at - http://www.ascca.org.au
*Note: The deadline for lodgement of entries has been extended to Mon 13 September 2010
(Click on ASCCA's latest newsletter) or a hard copy is available for reading at the Caloundra, Buderim and
Yandina Meetings during the month of Aug 10.
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Treasurer's Report
Income and Expenditure
2 June 2010 – 20 July 2010
Income
Fundraising
Interest
Meetings
Membership fees
Sales
Total Income
Expense
Administration
Fees and Memberships
Fundraising Expense
Hall Hire
Internet Service Provider
Library Expenses
Postage
Printing/Stationery
Refreshments and Entertainment
Sundry Equipment Repairs and
Replacements
Travel re-reimbursement
Total Expense
Net Income

Held at the Caloundra Community Youth Hall
7th August 2010

390.90
477.90
2,421.81
1605.54
40.00
4936.15
600.00
100.00
732.72
718.18
45.41
76.27
70.25
244.41
569.22
32.79
77.37
3266.62
$1669.53

Meeting: Commenced 11.00 am
Minutes of Previous Meeting No Business arising
from the previous months minutes.
Motion proposed by Ian Smyth that the previous
months minutes be accepted was Seconded by
Jim Jamieson. CARRIED
New Members: Peter Allery, Janice Heitman, Penny
Johnston-Brew, Robert Rutter,
Felicity Sewell, Ross Spicer, Ted and Marguerite Webber
Treasurers Report; Heather Atkinson presented the
Treasurers Report for the period 21/06/10 to 20/07/10.
This report is published in the Bits'N'Bytes.
Total income was $4,144.31 and total expenditure
$4,140.98.The amount for hall hire this month appears
to be irregular, because we did not pay any hall hire this
month, this will of course be rectified in next months
report.
The clubs annual insurance premium was paid. Heather
referred to the ad in this months magazine appealing
for a volunteer who has some book keeping ability to
take on the treasurers duties while she is on holiday.
While one person has already volunteered, a couple
would be an even better back up. Heather said it was
not a difficult job, just a question of learning the
method.
Heather Atkinson proposed that the Treasurer's
Report be Accepted, this was Seconded by Beth
Caithness CARRIED
General Business : Peter Daley announced that the
club is intending to improve its' website, Jean Lear had
offered to look after the basic administration of the web
site, but we are looking for people who would like to
contribute to it. The club is also looking at a couple of
other projects that will be announced at the next
meeting, or in the bulletins. As there was no further
business to discuss Peter called the meeting to a close
at 11.10 am.
Marie McGregor (Secretary)

Minutes of the General Meeting
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Blue Ray by President Peter Daley
Blue Ray is the latest disc movie technology that
promises a great improvement in picture, and sound
quality. Blank Blue Ray disc are available at present for
data storage that can store 25 GB per single layered,
and 50 GB per dual layered. This format is open-ended,
with a possible storage limit of 200 GB. So it could
become the next high volume storage media replacing
DVD discs.
It main purpose at present is to act as a medium to
distribute the latest high definition moves, (Highdefinition video is 1920×1080 pixel resolution / 60
frames per second / 24 frames per second). If you buy
a dedicated stand alone Blue Ray player you just put
the disk in and play it. Getting Blue Ray to work on an
computer can be whole lot more involved.
It is to do with the fact that you need a fairly fast
computer, and have a Blue Ray player installed plus
several layers of Content Management & Digital Rights
Management (DRM). The computer Blue Ray player
looks just like a DVD player, some are multi players that
can read older technologies like CD /DVD discs. Some
more expensive players can read and burn Blue Ray
data storage disks as well as play Blue Ray Movies.
Price ranges for Blue Ray Players are $200 to over $500
depending on what the player can do.
If you are looking at getting Blue Ray movies playing on
an older computer, most of you should just forget the
idea. Because of several layers of Content Management
& Digital Rights Management (DRM), getting all the
hardware parts to work together can be a nightmare.
See all the hardware has to be certified to be Content
and DRM certified and even then it may not work
together. You also need Content and DRM certified
software to play Blue Ray discs.
Blue Ray video movies have encryption to prevent
copying and the Content and DRM looks to see if the
hardware or movie disc has been tampered with. In
other words to see if the Blue Ray content is being
pirated.

It can,
1. See if a player’s keys have been changed.
2. Patch an insecure Content and DRM certified
system.
3. Stop the viewing of Blue Ray content if any
of the hardware, or software is not compliant.
Even if the hardware and software you are using is all
legal, and you have installed Content and DRM
compliant Blue Ray software, disc player, video card,
and Blue Ray compliant monitor it may not work. All the
bits may not talk to each other for some strange
technical reason! So after many hours of technical
support and research you may be faced with more
expense, and have no choice but to purchase and try
another compliant video card, different software, or
monitor to get it all working happily together.
Alternatively you could purchase a computer that is
already set up with everything, content and DRM
compliant, and ready to play Blue Ray movies out of the
box.
In reviews of Bue Ray movies reviewers have been
complaining that the sound and video quality has not
been up to the Blue Ray standard on lots of movies.
This is because some content creators are capitalising
on the Blue Ray hype, and supplying movies with
second rate video and sound quality. They then get top
dollar for second rate material.
There are some very well made Blue Ray movies. I
suggest reading reviews before purchasing any movie.
There are no where near the number of movies
available in Blue Ray format compared to DVD, which
most people are happy with. Now the industry is
pushing 3D as the next big thing! It is all about getting
you to spend money on new technologies.
© Peter Daley 2010
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Picasa 3 by Heather Atkinson
Picasa is an image organiser and viewer offered to you
for free by Google. It also does a whole lot more...
As with any program that you are looking at for the first
time, run through the menu items to get an idea of
what the program can do for you. I think you will be
pleased and amazed at what Picasa can effortlessly do
for you.

online image editor.
Add captions to your photos and this description will go
with the photo if you upload it or when you create a
web page or slide show.
Once you have your pictures as you want them you
might want to share them. Picasa gives you several
choices.
Email
You can email them - Picasa resizes them to a suitable
for email size before sending them.
Upload to Web Albums
Share your photos online. Upload them to Web Albums
which can be available for public or private viewing
according to your instructions. You can set up email
notifications to advise your friends and family that you
have added new photos.
Picasa Web Albums offers 1 GB of storage for photos
and videos, so this is also a good place to back up your
precious photos.

The Folder Manager, found under Tools in the menu
bar, allows you to control how Picasa looks for pictures
on your computer.
You can also import pictures from a device such as a
camera or a scanner or a storage device or a folder by
clicking on the Import button found at the top left of
the program.

Blog This!
Click on the Blog This! button and you will be taken to
the Google Blogger page where you can create a Blog
with your selected pictures. It's easy. Just follow the
instructions.
Collage
Select the images you want to use in the collage and
click the Collage button. You then have the opportunity
to resize, move and angle the pictures. You then have
the choice of creating a single jpg image of the collage
to print, email, upload, etc. Alternatively, click on the
Desktop Background button to save it and set it as a
new desktop background.
Movie
The Movie button will create a slideshow of your
selected photos. You can edit your movie with different
transitions, add an audio track, and resize before saving
it or uploading it to YouTube.
Picasa is a really versatile program that is simple to use.
Most features are achieved with a single click. For
download and installation instruction of this free
program go to
http://picasa.google.com/support/bin/answer.py?
hl=en&answer=106563

Picasa also edits your photos. Double click on an image
that you want to edit. You will find basic fixes, tuning
and effects available. One interesting option in basic
fixes is Piknik (http://www.picnik.com) which is an
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Goodbye Analogue TV by Bill Maxwell
Each of the four sites on the Sunshine Coast (Bald
Knob, Dulong Lookout, Black Mt, and Sunrise Road
Tewantin) and Tozer Hill in Gympie has a single
transmission tower for the Analogue and Digital signals.
Ten transmitters (five analogue, five digital) at each site
feed one antenna. So if your existing antenna is picking
up a good analogue signal chances are you will be able
to also receive the digital signal with out the necessity
of re-aiming your antenna. In addition to the Regional
stations being transmitted from Bald Knob, there are
additional transmitters on the commercial stations for
the Brisbane channels. All transmitters on the Sunshine
Coast transmit in the UHF TV band and are Horizontal
polarisation except for Sunrise Road which is Vertical.
There are no VHF TV transmitters on the Sunshine
Coast.
To receive the Digital signal you will have to purchase
either a new TV with a built in Digital Tuner or a Set
Top Box which converts the signal for the older TV sets.
If you find that the digital signal is not very good and is
dropping out or is having pixilation problems then you
may have to replace the antenna, the coax or the masthead amplifier.

replaced at great cost. Your only option in this case is
to put up your own antenna.
About the antenna, a word of warning:
There are some unscrupulous TV Antenna installers
marketing Digital Antennas at inflated prices. THERE IS
NO SUCH THING AS A DIGITAL ANTENNA. Your existing
antenna may be sufficient for Digital but if you
experience any problems you may have to replace it
with a HIGH-GAIN antenna operating within the same
frequency band (UHF) and polarity of the Digital
transmission. A High-Gain antenna has more elements
and can be quite larger than the standard antenna. See
picture below.
A good web site to visit for more information:
http://www.digitalready.gov.au/index.aspx
You have plenty of time. The Sunshine Coast and Gold
Coast have been lumped in with Brisbane and the cut
off date for Analogue is 30 June 2013.
Pictured is a High Gain UHF antenna.

Mast-head amplifiers are subject to all the weather and
rust which will cause signal loss. Older coax (RG-59)
will also cause signal loss and should be replaced with
the newer low-loss coax RG6 or RG11 as called for by
the new Australian Standards for Digital TV.
If you live in one of the retirement villages that has a
common antenna for all the units you may be in
trouble. I have found that the TV cabling in some of
these villages was not installed correctly and is having
trouble receiving the digital signals (too much line loss).
These villages will have to have the system totally
No one believes seniors . . . Everyone thinks they are senile.
An elderly couple was celebrating their sixtieth anniversary. The couple had married as childhood
sweethearts and had moved back to their old neighbourhood after they retired. Holding hands, they
walked back to their old school. It was not locked, so they entered, and found the old desk they'd shared,
where Andy had carved ' I love you, Sally'. On their way back home, a bag of money fell out of an
armoured car, practically landing at their feet. Sally quickly picked it up and, not sure what to do with it,
they took it home. There, she counted the money-fifty thousand. Andy said, 'We've got to give it back.'
Sally said,'Finders keepers.' She put the money back in the bag and hid it in their attic.
The next day, two police officers were canvassing the neighbourhood looking for the money, and knocked
on their door.'Pardon me, did either of you find a bag that fell out of an armoured car yesterday? 'Sally
said, 'No'. Andy said, 'She's lying. She hid it up in the attic. Sally said, 'Don't believe him, he's getting
senile'. The policemen turned to Andy and began to question him. He said: 'Tell us the story from the
beginning.' Andy said, 'Well, when Sally and I were walking home from school yesterday .....'
The first officer turned to his partner and said, 'We're outta here!'
Page 6
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SecondLife by Martin O'Sullivan
Ever thought of travelling to exotic locations. Visit
places of interest like the NASA Jet Propulsion
Laboratory, famous museums. You can Involve yourself
with Biology and Ocean Sciences. Art lovers may wish
to visit a recreation of The Sistine Chapel. All this and
more you can experience with Second Life.
You firstly need to join Secondlife by going to:
http://secondlife.com/
Here you may join for free. When you join you will be
asked select an Avatar to represent you on Secondlife.
Don't worry too much about its appearance because
you are able to change that later if you so desire. You
will also select a first and last name (need not be your
real name) and a password.
The linux version of the Second Life browser/ reader is
a 37.4Mb download available at:
http://secondlife.com/support/downloads/
The name of the tar file is:
SecondLife-i686-2.0.1.203797.tar.bz2
The tar file needs to be copied into a directory where it
can be un-ravelled.
I chose my /home/user/Downloads/ Having chosen
your directory installation is as follows:
Open the Dolphin file manager and go to the directory
where the .tar.bz2 file resides.
Right click on the file and select the “Extract Archive
Here” menu item. It will take half a minute or so. You
will find that Second life has now installed itself in
the /opt directory.
Once the installation is completed the original .tar.bz2
file can be deleted if 1748 you so desire. You will also
find that a SecondLife Icon has been installed in the
main menu, under the “Internet” menu item.
When you first open the SecondLife browser/reader,
you may receive a warning that your machine does not
meet with the minimum standards for SecondLife. The
requirements are listed at the following URL:

The pdf file will explain the SecondLife window. It will
show you how to move your avatar, to control
communication, etc. Especially useful is page 7 of the
quickstart guide. If you print it out it will assist you
greatly in the early stages of familiarisation.
SecondLife is the brainchild of the Linden laboratories.
Second life is constructed on different islands. There is
a map to help the new user to navigate these various
islands. You can use the search facility of the
browser/reader to find an island if you know its name
or description e.g. “Orientation Station, Bright”
(141,155,24). The numerals are the co-ordinates of the
island.
There is a website that shows all of the destinations at
together with a brief synopsis of what is at that island
site:
http://secondlife.com/destinations/
By going to this site with your Firefox Browser you may
choose a destination from this list. A script will come up
that will allow you to be transported to the selected
destination. (You need to be logged out of SecondLife
for this to work.)
Clicking on the script will then open the SecondLife
browser. You will need to type your Avatar's first name,
last name and password to login to the selected
SecondLife Island.
Although the idea was created by the Linden Labs,
many of the islands have their own creators (NASA JPL
is just one of these creators).
Two of NASA sites are “Explorer Island” and “Space Port
Alpha”. Try a journey to the space station via the
Gemini/Titan rocket. The launch pad is in the north
west of “Space Port Alpha.”
SecondLife has an introduction video clip which
introduces the basics of how to move about, explore,
meet other people, etc it once you are connected. It is
available at:
http://secondlife.com/whatis/

http://secondlife.com/support/system-requirements/
I have found that it is quite possible to run SecondLife
successfully even-though your machine does not fully
meet with the requirements. As a start point it is worth
downloading the quickstart pdf file
http://static-secondlifecom.s3.amazonaws.com/downloads/en/Second_Life_Qu
ickstart.pdf
Page 7
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Raffles
The last SCCC Raffle was drawn using the Random Number Generator at the Caloundra
meeting on Saturday 7 August 2010.
The winner received the prize of a Kobo eReader. The winning ticket number 222 which was
sold at Buderim Meeting by Fiona Allen-Sympson.
Thank you to the members who supported this raffle and to the members manning the desks
and selling tickets in the raffle.
Remember that if you have any suggestions for prizes for future raffles please e mail the Club
at - sccc@internode.on.net - or talk to the door persons at a meeting or to a member of the Committee.

The next SCCC Raffle will be drawn at the Buderim Meeting on Wednesday 1 September 2010.
The prize is a Nintendo Wii Console including Wii Sports. (Wii – pronounced ‘we’)

NO FAMILY SHOULD BE WITHOUT A NINTENDO WII.
Included with the Wii Console is the number one selling Wii game – Wii
Sport. Wii Sports offers – tennis, baseball, golf, bowling and boxing and is
extremely easy to use so that every member of the family from the very
young to the very old can play these games.
An extra game “Mario and Sonic at the Olympic Games” is included.
Any member of the family can pick up a remote and start playing some
fantastic Wii games.

RAFFLE TO BE DRAWN 2 OCT 10
The SCCC Raffle to be drawn on Sat 2 Oct 10 at the Caloundra Meeting has something that should provide a lot
of fun and entertainment for the member and their family.
The prize is a Panasonic SDRS50 SD Camcorder SD Card Camcorder with 33mm Wide-Angle, 78x Ultra Zoom
Using an SDXC/SDHC/SD Memory Card for recording media, the compact SDR-S50 is ideal for daily use.
Its superb resistance to external impact combines to give this versatile camcorder easy portability for anytime,
anywhere video fun.
Tickets are one dollar each and may be purchased at all Club Meetings.
Remember that buying tickets is voluntary.
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Open Office Tips by Jean Lear
•

Understanding Line Spacing in Open Office
Writer
Line spacing is not limited to single, 1.5, and double
line spacing in text in Open Office Writer. To explain
this - if a page is filled with text in double line spacing
and it goes just over to the next page but you want to
fit on just one page it is possible to reduce the line
spacing to somewhere less than double but not down
to 1.5 to fit into one page. (This is apart from reducing
the font size or increasing the margins of the page).
Left Click > Format > Paragraph From the Window
'Paragraph' Click 'Indents and Spacing' Tab. Near the
bottom of the page see Line Spacing and from the Drop
Down choose Leading. This activates a box opposite
where arrows give a choice of add or subtract. Choose
'lesser' and Click OK at the bottom of the window. If
this does not give the wanted result hold down the Ctrl
key (Control) and tap the Z key. This will return your
document to what it was before the change. It is then
possible to go through the process again till the desired
result is achieved. There are more changes that can be
made on the Indents and Spacing Tab and more on the
other Tabs in the Paragraph Window. Some of these
are already available through the icons on the Toolbars
above your document.
If you have a need to use this set up in future
documents it is possible to save it in a template.
Creating a new Default Template
If you want every new document to have user-defined
settings, you must create a new template and set it as
default.
1. Create a new document, add or modify styles,
and change other settings as you desire.
2. From the File menu, choose Templates -> Save.
3. Give the template a name.
4. Select a category in the Categories list (for
example, My Templates).
5. Click OK to save the template.
6. Choose File -> Templates -> Organise.
7. In the Categories list, double-click on the My
Templates folder.
8. Right-click on the template you want to use and
choose Set as Default Template from the menu.
9. Click the Close button.
A default template can be set for any OOo component
(Writer, Calc, Impress).

If you want OOo to check if the template has
been changed since you last edited the
document you're opening, the template had to
be saved with the method above (if it's located
in a different place, OOo can't check).

Omniglot
http://omniglot.com
Omniglot is an encyclopaedia of writing systems and
languages.
It contains:
* Details of more than 180 writing systems, including
Abjads, Alphabets, Abugidas, Syllabaries and Semantophonetic scripts
* Information about more than 500 languages
* More than 300 con-scripts - writings systems
invented by visitors to this site
* Tips on learning languages
* Language-related articles
* Useful foreign phrases with audio recordings in
numerous languages
* Texts, language names, country names, colours
and songs in many languages
* A language book store
* Links to language-related resources
You can find a guide to the contents of Omniglot on the
sitemap, and a list of all the writing systems and
languages featured on the site in the A-Z index.
Contained on the site are Writing Systems, Language
Learning, Articles, Phrases, Multilingual pages, Book
store, Puzzles, Gallery, Songs, Links, FAQs etc

Phone Choice
http://www.phonechoice.com.au
PhoneChoice is Australia's most established and
comprehensive site for all your
Telecommunications needs. You will find independent,
unbiased advice and solutions.
There is information on Mobile, Fixed Line, Broadband,
VoIP, Scams and Ripoffs, and a
forum to ask your questions. Included are rates and
plans, providers and network
coverage etc
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Bits and Pieces
The History and Copyright of Clip Art
http://www.aaronartprints.org/thehistoryandcopyrightof
clipart.php
Clip art is a collection of graphic images of various
shapes, sizes and colours, including maps, diagrams,
illustrations, cartoons and designs, available to you for
copying and pasting into your own page layout. You can
shop for any activity that needs an image, such as
business presentations, birthday/wedding invitations,
sports events, holiday greetings, etc. People associate
clip art with web decoration, but the images are also
available in printed format. Clip art consists exclusively
of illustrations, and excludes photographic images.
Clip Art History.
Clip art started as reproductions of simple line art
drawings. These drawings were pressed full size onto a
board where text or additional images were used. The
board would be referred to as a ‘mechanical’ and ready
for photographing.
When personal computers were introduced on the
market, the average users needed art to spice up their
projects. The clip art industry was initiated with the
creation of desktop publishing. In 1983 VCN Excuvision
introduced a package of clip art for pc users, and in
1984 Macintosh followed up with its own release,
graphical user interface (GUI), a term that has become
synonymous with web images. Also in 1984, the
package of illustrations called “ClickArt” was released.
It was not until 1985 when Aldus released Page Maker
5 for desktop publishing that clip art came into its own.
Aldus made it possible for the home user to produce
professional quality publishing, which rendered clip art
very popular and in great demand. People started
producing
business
presentations,
newsletters,
invitations, and brochures. Technology allowed for
simple designs and basic colours.
Steady progress was made in both home computing
and clip art. In the early 90’s, the production of CDs
with an array of electronic art became a necessity.
Microsoft began to include clip art in their products.
Another company, T/Maker, started producing massive
amounts of digital art. Some of their copyright free
collections
held
over
500,000
images.
Through the years, clip art has been a steady add-on
for computer programs and a revenue generator for
companies. In the 2000’s, the emergence of the
internet as a sales tool was recognised. Clip art on the
web was sold by reputable websites that are still
around today. Clipart.com, GraphicsFactory.com and
Weddingclipart.com have online libraries for sale,

allowing clip art to be sold not only as bundled software
from computer companies, but also as individual pieces
in a collection of illustrations. Moreover, subscriptions to
clip art websites are increasing at a fast pace. Clip art is
a mini industry that is proving to be self reliant and
here to stay.
Copyright for Clip Art Usage
The legal aspect regarding the usage of images on the
web has long been a grey issue. The web started out
with text only, left-justified, a warehouse of articles. It
was not until it was well established that images,
buttons and graphics were introduced. Unfortunately,
by that time, the action of downloading images for
personal reuse was rampant. Subsequently, companies
and their lawyers have now become vigilant with
respect
to
the
issue
of
copyrights.
The dictionary defines copyright as ownership over a
creation. Whether that creation is literary, audio,
musical, or has any other artistic attribute, its
ownership belongs to the creator. That copyright is in
force for the life of the creator and 50 years after. Just
because some of these creations are posted to the web
does not mean that the item is in the public domain.
Another great misconception involves the common
belief that if you download it and change it by adding
or subtracting from the creation, it then becomes yours.
That is wrong. You must obtain written permission from
the owner to reproduce or change clip art.
The terms for usage are dictated by the creator of the
company who owns the clip art. The reproduction terms
may be as simple as a few lines or as complicated as
the usage for major companies like Nike and Ford.
What you can and cannot use. You may use clip art
images when it is indicated that they are ‘free to use’
on commercial and personal web pages.
Before copying an image for your use, ensure yourself
that it is free to use on a personal web site. However, if
you have any advertisement on your website, the
copied image then becomes commercial and therefore
cannot be used on that particular website, unless it is
specified that it can be used on a commercial website.

The History and Copyright of Clip Art
Linkware images allow you usage of the image if you
link back to the creator’s page.
This issue is not one of entitlement but one of
ownership. If you are caught by the owner using his
image, legal action can be initiated, forcing you to
remove it and pay for past usage. Be wary because the
legal rulings with respect to clip art copyrights are far
from being lenient.
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Create a Booklet Using Open Office by Heather Atkinson
Create your document as normal using your default page size, usually A4. When you want to print it, select File
Print. From Options select Brochure and from Properties select Landscape.

That's all! Your booklet will be printed on landscape A4 paper which can be stapled and folded to make an A5
booklet with the pages in the correct order. If your printer can print duplex all the better. Otherwise you will have
to turn the pages over manually.

Page 11

Bits'N'Bytes

September 2010

More Bits and Pieces
SecondLife – Martin O'Sullivan Cont from page 7

Marine Traffic ProjectMarine Traffic Project

As well as Science/Technology and the arts, a number
of the Islands seem to cater for shopping, music, travel,
games players, scifi interests, the gothic and the
downright weird.

Imagine watching from your balcony and seeing a ship
passing. Go to the site - http://www.marinetraffic.com
– find the map of the local area and click on an icon
showing on the map about where you think the ship is
and see information about the ship such as name, ship
type, speed/course, length x breadth, draught,
destination, a picture of the ship etc.
This web site
provides an incredible amount of free real-time
information to the public, about ship movements and
ports, mainly across the coast-lines of Europe and
North America. The initial data collection is based on
the Automatic Identification System (AIS). As from Dec
04, the International Maritime Organisation (IMO)
requires all vessels over 299GT to carry an AIS
transponder on board, which transmits their position,
speed and course, among some other static
information, such as vessel’s name, dimensions and
voyage details. AIS is initially intended to help ships
avoid collisions, as well as assisting port authorities to
better control sea traffic. AIS transponders on board
vessels include a GPS (Global Positioning System)
receiver, which collects position and movement details
and makes this data available to the public domain.
Other vessels or base stations are able to receive this
information, process it using special software and
display vessels locations on a chart plotter or on a
computer. The site covers the world and as with
Google Maps it is possible to go to any part of the
world. The site has a lot of information and Frequently
Asked Questions about each part of the site. Visit the
site and see just how much information is available for
world wide use.

Some islands are still under construction and
development. Some sites e.g. “World Explorer Railway
Centre” are in the embryonic stage.
The globe icon opens a map of the island. A mini map
is also available under the “World” menu of the
SecondLife browser. Both of these can be of assistance
in orienting your Avatar.
Enjoy the SecondLife experience.

Globalization:
Question: What is the truest definition of Globalization?
Answer: Princess Diana's death.
Question: How come?
Answer : An English princess with an Egyptian
boyfriend crashes in a French tunnel, riding in a
German car with a Dutch engine, driven by a Belgian
who was drunk on Scottish whisky, (check the bottle
before you change the spelling), followed closely by
Italian Paparazzi, on Japanese motorcycles, treated by
an American doctor, using Brazilian medicines.
This is sent to you by an Australian, using American Bill
Gates' technology, and you're probably reading this on
your computer, that uses Taiwanese chips, and a
Korean monitor, assembled by Bangladeshi workers in a
Singapore plant, transported by Indian truck drivers,
hijacked by Indonesians, unloaded by Sicilian
longshoremen, and trucked to you by Mexican
illegals.....
That, my friends, is Globalization !
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Corporate Members

Help with Computers

Peter Daley

Andrew Hadland Diploma ICT
Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware – Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for Windows
and Linux. Data Recovery, Computer and
Internet
Training
and
Setup.
Home
Entertainment and Hi Fi systems setups and
advice. Custom built computers, all computer
systems are tested before pickup. Award
Winning Web Page Designer!
E-mail: ( Peter Daley)...

PH 0754913279
| Free Books | | Links | | E-mail |

Computer - Repairs - New Systems

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email
gregalach54@westnet.com.au
If you are ill or incapacitated or know of a club
member who needs some assistance or would
like to hear from the Club
contact our Welfare Officer Marie McGregor

Find Your Membership Number
Do you read your Bits'N'Bytes each month? Find your membership
number hidden somewhere in one of the pages and win five free tickets
in the current raffle.
The membership number will be chosen at random and will appear as a
four digit number within the text of the magazine and may be on any
page. If your membership number has 1, 2 or 3 digits, it will be shown
with leading 0s.
Do not forget to thoroughly scrutinise every magazine for your membership number hidden within the text of
articles each month.
The number is placed in the 8672 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005 to claim your
prize. You are allowed 60 days from the publication date to claim your prize. Otherwise, the prize is forfeited!
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Classified Ads
Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or
electronic hobbies etc. Adverts for other types of household goods will be accepted only if
there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .

FOR HIRE OR LOAN
The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners,
scanners, digital cameras, etc.
This equipment is available for hire or loan to
members when it is not required by the club for
meetings and presentations.
Contact your club if you need to borrow or hire
equipment.

Email: sccc@sccc.org.au
Telephone: 0754921005
FOR SALE

Antec Overture 11 Black
Piano style box
in very good condition.
$60
Phone J Skinner
54922671 Mob 0407113280

Place Your Classified Ad on this page.
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Item (Prices include GST)

Number

Club CD - Packed with free software, games and books.

@ $10 each

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2009.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc.
Multimedia CD Upgrade (With old version CD returned)

Cost

@$10 each
@ $5 each

Postage (for one or more CDs)

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed
Cheque / Money Order / Cash

4551
Total

Surf Watch - Members Web Sites...Submit Yours

Member
Peter Daley

Very Useful Links
http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Club Intranet
The Club Intranet is available at all meeting venues. It is packed with up to date free software, tutorials and back
issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:
192.168.2.222 (If you are at Buderim) or 192.168.0.222 (If you are at Caloundra or
Yandina)

Your Committee
President

Peter Daley

5491 3279 (VOIP)09134402

Vice President

Tony Tasker

5476 7129

Secretary

Marie McGregor

5492 5443

Treasurer

Heather Atkinson

5444 0886 (VOIP)09110928

Administration Co-ordinator

Jean Lear

5492 1151

Committee

Tom Bray

5479 3149

Committee Morry Phillips

Morry Phillips

5491 1148

Committee

George Lupsa

5445 3850

Committee

Jim McGregor

5492 5443

Committee

Ian Smyth

5491 9139

Committee

Andrew Hadland

5491 8645

Committee

Don Wallace

0401093692
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Membership fees include the electronic version of the club
magazine.

Yandina

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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